
ZipIt version 1.1

Introduction

The  zip  format  of  file  compression  is  a  standard  on  almost  all  computers  except  the 
Macintosh. ZipIt is a program that is designed to allow Mac users to easily create and 
decompress zip archives, especially to facilitate the exchange of data between platforms. 
ZipIt has a complete Macintosh interface, so it should be intuitive for the average Mac 
owner to use. In addition, ZipIt is able to compress Macintosh files using the MacBinary 
format,  which allows it  to  fully  reconstruct  any Macintosh file,  including applications, 
without sacrificing compatibility with other zip implementations.

What can ZipIt be used for?

ZipIt  is  fully  compatible  with  PKZip and all  other  standard zip  implementations.  This 
means you can unzip any file zipped on any other computer, and you can zip files destined 
for other computers as well. Furthermore, ZipIt can zip Macintosh files, retaining all the 
Macintosh information. 

In addition, ZipIt is AppleEvent-aware. It will receive the standard suite of AppleEvents, 
and has also defined its own suite that it accepts to compress and decompress files. This 
means that other programs can use ZipIt, and may even require ZipIt, to zip or unzip files.  
One such program that uses ZipIt is Freddie. Freddie is a QWK offline mail reader. It 
allows users to read messages from a BBS that supports the QWK mail packet format 



while not logged on to the BBS. Freddie uses ZipIt to decompress the QWK mail packet.



Shareware

ZipIt is $10 shareware. After you pay your shareware fee, you will receive a password to 
disable the registration screen that appears whenever you launch an unregistered copy of 
ZipIt.  Additionally,  if  you  are  registering  from the  United  States,  you  will  be  able  to 
encrypt  (password-protect)  zip  file  entries,  and  unzip  other  zip  files  that  have  been 
password-protected. To pay for ZipIt, please launch it and click “Print Registration Form.” 
Fill out the form, and mail it to me with $10 in check or money order. Please do not send 
cash.  If  for  some reason  you  cannot  print  out  the  registration  form,  send  me a  letter  
including the following:

Your name
Address
Telephone number
Version of ZipIt that you are using (available in the about box)
Where you obtained ZipIt
How you can be reached, if at all, online

If  sending  a  check,  please  make  it  out  to  Tommy  Brown,  and  send  the  check  and 
registration form to:

Tommy Brown
110-45 Queens Blvd Apt. 716
Forest Hills, NY  11375

I will send you your password either in the mail or at one of the online addresses that you 
specify.

Note: If you own Freddie v.1.2.5 or above, the Macintosh QWK reader by Kem Tekinay, 
follow the instructions in Freddie’s documentation, instead of the above instructions, to 
register ZipIt along with Freddie.

Legal notice: The $10 shareware fee is for ZipIt as a package. Technically, the $10 covers 
only that portion of ZipIt which is copyrighted by Tommy Brown. The code to zip and unzip 



files is copyrighted by others, as noted elsewhere in this documentation, and those portions 
of ZipIt are free. 



Source Code

While I will not release the entire source code for ZipIt, I would be glad to mail out copies 
of the zipping and unzipping code upon which ZipIt is based. This code is available on 
many  BBSes,  but,  if  you  want,  please  send  me  a  disk  and  a  self-addressed  stamped 
envelope at the address listed above, and I will copy onto the disk the source to Zip 1.0 and 
UnZip. Both programs are written in C. You may send single-sided, double-sided or high-
density disks.

Using ZipIt

Zipping files

ZipIt works just like a regular Macintosh program. To create a new zip archive, simply 
choose “New” from the  File menu. You can also add files to an existing zip archive by 
choosing “Open…” from the File menu and then adding files. To add files, simply choose 
“Add…” from the Zip menu. Double-click on a file you want to add, or select the file and 
click “Add.” You may add as many files as you like. When you are finished, click “Done.” 
Next, choose “Save” from the File menu, and the files you’ve added will be compressed 
and saved into the zip archive. Note that files are not compressed until you actually save 
the archive.

Unzipping files

To unzip files from an existing zip archive, choose “Open…” from the File menu and open 
the zip archive. The number of open windows in ZipIt is limited only by available memory. 
Select the files that you want to unzip, or choose “Select All” from the Edit menu to select 
all  the  files.  Hold  down  the  command  key  while  clicking  to  select  more  than  one 
discontiguous file, or the shift key to select multiple files that are displayed contiguously. 
Choose “Extract” from the Zip menu or double-click on one of the selected files. Find the 
folder into which you want to put the extracted files, and rename the first file if you want 
by changing the name in the dialog box. Then choose either “Save” or “Save all.” If you 



choose “Save all,” all the files will be stored in the same folder, using their original names. 
If you choose “Save,” ZipIt will ask you where to put each file.

Note: If any file has a name longer than 31 characters (i.e., if it was zipped 



on a Unix-based system), ZipIt will truncate the filename to 31 characters. This may 
cause problems if there are multiple files which do not have unique filenames up to 
the 31st character.

Zip archive manipulation

In addition to simply zipping and unzipping files,  you can change the zip archive in a 
number of ways.

Renaming files. To rename an entry in the zip archive, select the file that you want to 
rename and choose “Rename…” from the Zip menu. If the file is a Macintosh file, and has 
been zipped using MacBinary, then in this dialog you may specify only the new Macintosh 
filename.  The  actual  zip  filename  will  change  to  a  DOS  interpretation  of  your  new 
Macintosh filename. So for example, if you renamed an application ZipIt, the zip filename 
would become ZIPIT.BIN. The only time this would matter would be if this entry were 
unzipped by a program other than ZipIt. For more information on MacBinary in ZipIt, see 
the section on MacBinary below.

Adding comments. ZipIt supports comments for each zip file entry, as well as for the 
entire zip archive. To add or edit the comments for an entire zip archive, choose “Edit Zip 
Comments…” from the  Zip menu when the  desired  zip  archive  is  open.  You will  be 
presented with a dialog box into which you may enter your comments. You can include 
returns in your comments; in fact, if your zip archive will be used on a non-Mac machine,  
it would be advisable to press return after every line of comments.

To add comments for an individual file, select the file and choose “Edit Entry Comments.” 
ZipIt will not allow you to have more than 255 characters in an entry comment, and, if your 
zip archive will be used on a machine other than a Macintosh, you should restrict your 
entry comments to one line (80 characters) in length.

When there are comments for an entry, a small document icon will appear on the entry’s 
line.  When there are comments for an entire zip archive,  a  document icon will  appear 
above the scroll bar. You may click on these icons to view or edit the comments. This is  
functionally identical to choosing the appropriate menu 



command from the Zip menu.

To remove a comment, simply delete the entire text of the comment.

Removing files. ZipIt also allows you to remove files from a zip archive. Simply select the 
files to be removed and choose “Remove…” from the  Zip menu. ZipIt will ask you to 
confirm that you really want to remove these files, and then will delete them from the 
listing. After you choose “Save,” the files will be permanently removed from the archive.

Getting detailed information. If you select one or more files in a zip archive and choose 
“Get Info” from the Zip menu, you will get windows giving you detailed information on 
the selected files. The first piece of information is the file name, both the Macintosh name 
and the name in the zip archive. (For more information about the nature of file names in  
ZipIt, see the section on MacBinary, below.) For files that were not zipped with MacBinary, 
the Macintosh name and the name in the zip archive will be the same. The rest of the 
information in the Get Info box should be self-explanatory.

Sorting the zip archive. You may choose any item from the “View” menu to sort the zip 
archive. You may sort the entries by order saved, file name, expanded size, zipped size,  
percent saved, zipping method used, date that the file was last modified, and whether or not 
MacBinary was used. Note: This does not affect the contents of the zip archive, only the 
order in which they are displayed. You may sort the zip archive in any of the above orders, 
except  “Order  Saved,”  by  clicking  on  the  corresponding  heading  in  the  zip  window. 
Viewing by order saved, the default, is actually not sorted at all.

Encryption

Encryption is only available in versions of ZipIt registered to users in the United States,  
due to the United States export law. You must register your copy of ZipIt to get encryption 
features; see the section entitled “Shareware,” above, for details. With encryption, you can 
protect a file so that it will be impossible to unzip without the proper password.

Encrypting a file. First, add the file to a zip window, if the file is not already 



there, by choosing “Add…” from the  Zip menu. Next, select the file that you want to 
encrypt. You can encrypt files that have already been saved in the zip archive if you wish. 
Choose  “Set  Password…” from the  Zip menu.  (This  choice  will  only  be  available  on 
versions of ZipIt that have encryption enabled.) Type in the password you want to use, then 
re-type your password in the second field. Click OK, and a lock icon will appear next to the 
file. That means that the entry will be encrypted as soon as you save the zip archive.

Unzipping and decrypting a file. If you try to extract an encrypted file, ZipIt will ask you 
for the password to use when decrypting it. Simply type in the correct password, and ZipIt  
will be able to unzip the file. ZipIt will remember the password until you close the zip 
archive, so if you need to unzip it again you do not need to re-enter the password. You may 
also tell ZipIt the password in advance by selecting the encrypted files and choosing “Set 
Password…” from the  Zip menu.  If  more  than  one  encrypted  file  in  a  zip  archive  is 
encrypted with the same password, simply select all the files that use that password, choose 
“Set Password…” and type the password. This prevents you from having to enter the same 
password repeatedly.

Decrypting a file without unzipping it. You can remove the password from a zip entry 
while keeping it in the zip archive. After doing this, and saving the zip archive, a password 
will no longer be needed to unzip the entry. Select the entry that you want to decrypt (it  
must  have a lock icon next  to it,  indicating that  it  is  encrypted) and choose “Remove 
Password…” from the Zip menu. Unless the files that you chose were not yet saved, you 
will be prompted for the password to the entries. Enter the password, and the lock icon will  
change to an open lock. This open lock icon signifies that ZipIt will decrypt the entry as 
soon as you save the zip archive.  Note: ZipIt does  not check to see if your password is 
correct when you enter it. If you type the wrong password, ZipIt will not be able to decrypt 
the file and, after the zip archive is saved, the entry will remain encrypted.

MacBinary

MacBinary a protocol that was designed to facilitate file transfers of Macintosh files. It is a 
method of storing all the information necessary to recreate an entire Macintosh file in one 
data  stream,  instead  of  the  two  forks  plus  extra  file  information  that  the  Macintosh 
normally uses. ZipIt uses MacBinary to store 



Macintosh files inside a zip archive.

Zip archives created with ZipIt  are always compatible with other  zip implementations. 
However, if you are zipping a file intended for use by a computer other than the Macintosh, 
you should not use MacBinary when zipping that file. If you do, then, after unzipping the 
file on the other computer, the resulting file will have extra Macintosh data.

You  can  control  whether  or  not  ZipIt  uses  MacBinary  by  simply  clicking  in  the 
“MacBinary” column on the zip window. If there is a hollow circle there, then MacBinary 
will not be used to zip the file. If there is a filled circle, MacBinary will be used. You can 
only change the MacBinary status of a file before it has been saved. You cannot convert a 
file to MacBinary or vice-versa after it has been zipped and stored in the archive.

One consequence of MacBinary usage is that ZipIt keeps track of two separate filenames 
for  each  entry.  The  first  filename is  the  name as  it  is  written  in  the  zip  archive.  For 
example, if you zipped a Macintosh application called “Cool World,” ZipIt would store the 
name as COOLWORL.BIN. If another zip program opened this zip archive, it would think that 
the name of  Cool  World was  COOLWORL.BIN.  This  is  useful  because computers  running 
operating systems such as DOS could then unzip the file. ZipIt, however, will always know 
that the name of the file is Cool World. So whenever you open the file with ZipIt, you will 
see that the name is Cool World.

You can see this feature in action. Add any Macintosh file to a zip window and click on the  
MacBinary oval. When MacBinary is on, you will see the “real” Macintosh name. When 
MacBinary is off,  you will  see ZipIt’s best  approximation of the Macintosh name in a 
format acceptable to other computers. When renaming files, you can only change the name 
that is currently visible; that is, if the file is MacBinary, you can only change the Macintosh 
name, otherwise you can only change the zip file  name. In fact,  in the latter  case,  no 
Macintosh name is stored at all, so the only name that exists is the name as stored in the zip 
file.

You can control how ZipIt decides whether to use MacBinary. Choose “Preferences” from 
the File menu. You will see a choice, “Use MacBinary: Always, When needed, Never.” If 
you choose “Always,” then any file you add will have the MacBinary indicator filled in. If 
you choose “Never,” then ZipIt will 



never  fill  in  the  MacBinary  dot.  If  you  choose  “When  needed,”  ZipIt  will  only  use 
MacBinary  if  the  file  has  a  resource  fork.  You  can  always change  whether  or  not 
MacBinary  will  be  used  on  an  unsaved  file  by  clicking  on  the  dot  in  the  MacBinary 
column, no matter what the settings in the preferences dialog are.

One last note: If you unzip onto a non-Macintosh computer a file that ZipIt has stored as 
MacBinary, and then bring the file back onto a Macintosh, you will have to convert the file 
to a Macintosh file using one of the many Macintosh utilities that can convert MacBinary 
files to Macintosh files.

Linefeeds

ZipIt supports a smart way of converting text files for use on Macintosh systems. If the 
strip linefeed option under the Zip menu is checked, then ZipIt will strip the linefeeds from 
a file that it is extracting if the following conditions are met:

a) the file is marked as a text file in the zip archive or it has a special text file extension;
b) the file was not zipped on a Macintosh;
c) the file’s name does not match any of the special binary names (see below);
d) the preferences specify to strip linefeeds.

If all three of these conditions are met, then ZipIt will strip the linefeeds in a text file. It  
will do this in one of two manners. If the format of the file is such that each carriage return  
is followed by a linefeed, then ZipIt will simply delete all the linefeeds in the file. If the file 
consists of lines ending with linefeeds alone, not preceded by carriage returns, then ZipIt  
will change all the linefeeds into carriage returns. This is to support Unix-style text files. 
Note that ZipIt makes its determination about whether or not to strip linefeeds from each 
individual  file  as  soon  as  the  archive  is  opened.  Therefore,  you  may  override  its 
recommendations  for  any individual  file  simply  by selecting  that  file  and checking or 
unchecking “Strip Linefeeds” in the Zip menu.

Special binary files. (If you are not comfortable with ResEdit, please skip this section, as 
ResEdit could potentially damage your copy of ZipIt.) There will be times when a binary 
file is incorrectly labeled as a text file in the zip archive. If you frequently unzip a binary 
file with the same name, and you would like to prevent ZipIt from stripping linefeeds from 
files with that name, you may do so. One example is the use of ZipIt to decompress QWK 



packets. The 



MESSAGES.DAT file is often marked as a text file, even though it is not, and stripping 
linefeeds in that file would probably result  in its  corruption. For that reason, an STR# 
resource, with an ID of 400, is provided. Using ResEdit  on a copy of ZipIt, add a string 
containing  the  name  of  the  binary  file.  Two  such  names  are  already  provided: 
MESSAGES.DAT and ***.NDX (the latter  matches all  filenames in  the form of  three 
characters plus the “NDX” extension). Asterisks are permitted as wildcards, but only match 
a single character. There is no way to match more than one character.

Special text files. When a file is zipped, the zipping program puts a mark in the zip archive 
stating whether the file is a text or binary file. ZipIt assumes that the program that created 
the zip archive knew what it  was doing when it made this determination, which is not  
always  the  case.  Some  files  are  obviously  text  files,  however,  such  as  files  with  an 
extension of .TXT, .DOC, or .HQX. You can add to the list of text file extensions that ZipIt  
knows about by using ResEdit. Open a copy of ZipIt using ResEdit, double-click on the 
STR# resource, open the resource with an ID of 401, and add or delete strings. Each string 
should consist of at most three letters — the file extension. Any file that ends with this 
extension will be recognized by ZipIt as a text file.

Customizing ZipIt

This section discusses the various options available by choosing “Preferences…” from the 
File menu.

Look inside  each  file  to  determine  if  it  is  a  zip  file. By  default,  when  you  choose 
“Open…” from the  File menu,  ZipIt  will  display any file  that  has  a  type of  ‘TEXT’, 
‘pZIP’, or ‘ZIP ’. However, you may have Zip files with other file types, or you may want  
to display only the real zip files. This option reads each file to determine whether it is a real 
zip file before displaying it in the open dialog box. This is slightly slower, but will display 
all zip files, and only zip files (not regular text files). For you advanced types out there,  
ZipIt checks to see if the first two characters of each text file are PK; if so, it assumes that  
the file is a zip file. In order to accept self-extracting archives, ZipIt will also display any 
file beginning with the letters MZ; consequently, all IBM executable files will be displayed 
by ZipIt, whether or not they are actually zip archives.



Do not put up notification dialog boxes while in the background. Under System 7 or 
MultiFinder, ZipIt may need to inform you of something while it is in the background. 
Normally, if ZipIt has to inform you of some fact, it will put up a dialog box (using the 
Notification Manager) telling you what it has to tell you, then allow you to continue to 
work (after dismissing the alert). Enabling this option will make ZipIt flash its icon in the 
Apple menu or applications menu and wait for you to switch it into the front before telling 
you anything. This may be less disruptive if you are working on something and do not want 
ZipIt to interrupt you.

Open an untitled window when first starting up. This option is on by default. It has 
ZipIt open an empty, untitled window when it first starts up if no documents were chosen 
from the Finder. If you turn this option off, then ZipIt will not open any windows when it 
starts up.

Always replace existing files; do not ask. If you are extracting files and choose “Save 
all,” then ZipIt will continue to extract files in the same folder unless it tries to extract a file 
with the same name as a file already existing. In this situation, ZipIt will normally ask you 
what to do in the form of another save dialog box. If you select this option, then ZipIt will 
not ask you what to do; instead, it will simply replace any existing files with the same 
name as a file that ZipIt is extracting with the extracted file. This option is potentially 
dangerous, as you could lose files without knowing it.

By default, smart-strip linefeeds from text files. If this is set, then ZipIt will attempt to 
figure out whether or not linefeeds should be stripped from text files when you unzip from 
an  archive  created  on  a  computer  other  than  the  Macintosh.  This  preference  should 
generally be set; you may always override ZipIt’s recommendation by selecting the entry 
from which you do or do not want to strip linefeeds, and choosing “Strip Linefeeds” from 
the Zip menu.

Binary file type. This allows you to set the Macintosh file type with which non-Macintosh 
binary files are stored when unzipped onto the Mac.

Binary file creator. This allows you to set the Macintosh file creator with which non-
Macintosh binary files are stored when unzipped onto the Mac.



Text  file  creator. This  allows  you  to  set  the  Macintosh  file  creator  with  which  non-
Macintosh text files are stored when unzipped onto the Mac. All text files have 



the file type ‘TEXT.’

Use MacBinary… These options allow you to specify when MacBinary should be used by 
default. See the section on MacBinary, above, for more details. Remember that you can 
always change whether or not MacBinary is to be used on an unsaved file by clicking in the 
circle in the “MacBinary” column of the zip window.

Default compression… See section entitled “PKZip 2.04g” below.

PKZip 2.04g

Starting with version 1.1,  ZipIt  can both compress and decompress files  in PKZip 2.0 
format, and is fully compatible with PKZip 2.04g, the latest version as of this writing. A 
new preference has been added to accommodate the new compression technique, called 
“deflation.” In the preferences dialog box, you may now choose to have ZipIt default to 
either deflation or implosion. If you choose deflation, then whenever you add a file to an 
archive, ZipIt will default to deflating the file, and will display “Deflated” in italics to  
indicate this. If you choose “Implosion”, ZipIt will use the old method. When you add a 
file, “Best Guess” will be in italics, indicating that ZipIt will use its best guess to choose 
between implosion or shrinking (in most cases, ZipIt will  choose implosion). You may 
always change the compression method used simply by choosing the new method from the 
Method  menu.  Note  that  “Best  Guess”  now  means  the  best  PKZip  1.x-compatible 
compression. Deflation will always be more efficient, but will not be compatible with older 
versions of unzipping programs.

To summarize:  If  you want  to create the most  compatible archives possible,  go to the 
Preferences… dialog and choose “Default compression: Implosion.” If you want to create 
PKZip 2.0 compatible archives, or don’t care about compatibility but want the smallest 
archives, go to the  Preferences… dialog and choose “Default compression: Deflation.” 
You can always override the default compression by choosing a new compression method 
from the Method menu.



ZTerm



(If  you are  not  comfortable  with  ResEdit,  please  skip  this  section.)  ZTerm provides  a 
feature that allows you to indicate to ZTerm that zip files should be marked with a ZipIt  
creator. If you do this, then, whenever you double-click a zip file that you have downloaded 
with ZTerm, ZipIt will launch. ZTerm sets downloaded zip files to launch the application 
UnZip by default.  Please read the following steps in their entirety before attempting 
this procedure.

1. Launch ResEdit.
2. Use ResEdit to open your copy of ZTerm. Make sure you have a backup just in case.
3. Double-click on the ‘STR#’ resource.
4. Double-click on resource ID 335, which should be called “Bin Detect”
5. String #4 should currently read “0pZIPpZIPPK”. Replace each occurrence of “pZIP” 

with “ZIP ”. Do not forget the space at the end. The string should now appear as “0ZIP 
ZIP PK”.

Warning: There are two invisible characters at the end of this string. These characters 
must remain there. For this reason, I recommend that you do not select the 
entire string and re-type it, but rather just select the two “pZIP”s and change 
them.

6. Close resource ID 335 and open resource ID 330.
7. Scroll to the bottom and click on the row of five asterisks. Go to the Resource menu and 

choose “Insert New Field.”
8. In the blank field, type “ZIP ”, without the quotes.
9. Save ZTerm and quit.

Future Plans

• Add a filename filter for the Open dialog box, so that, if the user selects this option, 
ZipIt will only display files ending with ‘.zip’ or ‘.exe’.

• Extension mapping for extracted files. Files ending in ‘.txt’ will become text files, files 
ending in ‘.doc’ will become Microsoft Word documents, etc.

• Recognizing  and  supporting  folder  structure.  This  means  both  including  folders  in 



archives, and recognizing pathnames and converting them to folders when displaying 
archives on the Mac. This will definitely be in the next version, as I have already begun 
work on it.



• Add an “Add All” command when adding files to a zip archive to add all files in the 
current folder.

• Possibly add a floating palette.
• Speed ZipIt up by making the file i/o routines call the Mac toolbox directly. This is  

another revision that I hope to complete for the next version.

Known problems

• Possible erroneous reporting of “Not enough disk space available,” but I haven’t been 
able to reproduce this one.

• Possible crashing during printing, especially using a Stylewriter. Since I don’t have one 
of these, I haven’t been able to reproduce this bug (background printing works fine with 
my Laserwriter), so if anyone else has this problem, please let me know.

• Possible incompatibilities with FileGuard.

Troubleshooting

The problem most often reported to me is that after transferring the file to another machine, 
for  example  an  IBM,  it  is  no  longer  unzippable.  I  have  never  been  able  to  find  a 
circumstance in which this is true, so I think that in these cases, the problem lies in the 
transfer process. Here are a few things to try if you are not able to unzip ZipIt-created files 
on your IBM:

• Are you using MacBinary in  your  terminal  program? Make sure that  you tell  your 
terminal program not to use MacBinary when transmitting the zip file. Note that this is 
different from telling ZipIt whether or not to use MacBinary when zipping the files.

• Are you sending the file in text or binary mode? Some terminal programs allow you to 
specify — make sure binary is chosen, but not MacBinary.

• Try sending the file over with a different terminal or transfer protocol. If you were using 
ZModem, try YModem or XModem-1K.



• Have you tried using a diskette to transfer the zip file? Put in a disk, initialize it with 
Apple File Exchange or an equivalent program, then copy the zip file onto 



the disk using no translations.
• Try transferring the file to your other computer and then back to your Mac. Make sure 

that MacBinary is turned off both times (when sending and receiving from the Mac 
end). Can ZipIt still open the file, or did it get corrupted somewhere in between?

If you still can’t figure out the problem, please contact me and I’d be glad to help you out.

How to contact me

In order of preference

America Online: Tommy6
Internet: tommy6@aol.com
FidoNet: 1:2603/204 (Not Even Odd BBS) - Tommy Brown
GEnie: P.L.COOPER
Compuserve: 70314,3342
Forest Hills BBS: 718-268-1240 - Tommy Brown
Not Even Odd BBS: 718-997-1189 - Tommy Brown

Changes history

Version 1.0 - January 25, 1993 (intial release)

Version 1.1 - March 20, 1993

• Alert added when trying to unzip an unsaved file.

• Now beeps after unzipping only if unzip took more than one minute

• Whenever  you open a  file,  the  standard file  dialog box now defaults  to  the  most 
recently-opened zip file when extracting files. In other words, ZipIt will now default 
to unzipping files into the same folder as the archive. This was usually, but not always 
true in previous versions. (Thanks to Bill Kearney for reporting this.)



• Updated ZipIt to include Info-Zip’s version 5.0c10p1 inflating code. This code works 
around a bug in PKZip 2.04c. ZipIt 1.0 used version 5.0c7 of the Info-Zip code.

• Added elipses to end of the “Extract” menu command. This should have been there in 
the first 



place,  but  for  some  reason  wasn’t.  This  also  fixed  a  bug  with  help  balloons  not 
appearing for  the  “Extract”  command in  unregistered and internatonal  versions  of 
ZipIt.

• Fixed a bug in which ZipIt would choke upon attempting to open a zip file which 
contained very long (more than 255 byte) strings in the central file header. Now ZipIt 
will  ignore any characters past  the 255th in the extra,  filename, and file comment 
fields of the central file header. Thanks to RichardJ11 on AOL for reporting this.

• Added totals at the bottom of the zip window. ZipIt will now display the total number 
of files in the zip archive, the total compressed size, the total uncompressed size, and 
the total percentage saved.

• Fixed a bug in which in some circumstances under system 6, the _IZIPTMP file was 
not being deleted.

• Fixed a bug in which under system 6, sometimes the zip file was unable to be renamed 
and was left  as  _ZZIPTMP. Thanks to  CZiemer of  AOL for  reporting this.  Many 
apologies to all the system 6 ZipIt users for this bug..

• Fixed a bug in which, under system 6, new zip files didn’t have their Finder flags 
properly initialized. This led to invisible zip files, zip files with strange colors, etc. 
Thanks to Booooooo, formerly of AOL, for reporting this.

• Added deflation! Also added new preference allowing you to control whether ZipIt 
defaults to deflation or implosion.

• Changed  behavior  of  ‘special  text  file’  identification  (ie  recognizing  files  with 
extensions of ‘txt’, etc as text files) to be case-insensitive. Only a problem for zip files 
originating on systems with lowercase filenames such as Unix.

• Changed behavior of the menu choice “Strip Linefeeds” in the Zip menu. Here’s how 
it works now:

When you first open a zip archive, for each individual entry, ZipIt determines 
whether or not linefeeds should be stripped from that file. It bases its decision on 



the following pieces of information:
A. Do the prefs specify to strip linefeeds?
B. Is the entry marked as a text file?
C. Is the entry a ‘special text file’?
D. Was it made on a Mac?
E. Is it a special binary file?

It uses this information to determine the default setting of the menu item. You 
may always override this simply by checking or unchecking the Strip Linefeeds 
item. For example, if you have a text file which does not end with “.TXT” and 
was marked by the zipping program as binary,  you can now have ZipIt  strip 
linefeeds simply by checking the option under the Zip menu.

• Added ‘????’ to the list of file types ZipIt will open.



• Fixed a bug in which ZipIt would crash upon opening a zip file of more than 100 
entries. Thanks Tony for first reporting this and Kem for furnishing a zip file which 
demonstrated this behavior.

• Fixed minor printing bug. (I couldn’t reproduce the crashing problem reported by Josh 
Dallagiacomo, but maybe the fix that I implemented will cure his problem as well?)

• Divided Preferences dialog box into two dialogs: One for “Miscellaneous” prefs, and 
one for “Compression” preferences.  Also added a new preference allowing you to 
choose between ‘ZIP ’ and ‘TEXT’ for the file type for created archives. In general, 
you should use ‘ZIP ’, and should only use ‘TEXT’ if you’re using a terminal program 
which insists on adding a MacBinary header to any non-text file.

• Changed the  Entry  Comment  and  Zip  Comment  dialog  boxes  so  that  the  prompt 
section is in the system font.

• Added an on-screen indication of whether or not linefeeds will be stripped from files 
when they are unzipped. This indicator works identically to the MacBinary indicator, 
in that  it  can be turned on and off  by clicking on it.  Clicking in this  indicator  is  
identical to checking or unchecking “Strip Linefeeds” under the Zip menu.

• Fixed a bug introduced only in 1.1 betas in which, under system 6, the default folder 
in open dialog boxes would always be set to the root folder of the startup volume.

• Fixed the behavior of the window positioning routine. On 9-inch screens, there is no 
room to stagger zip windows horizontally. Previous versions of ZipIt would just stick 
windows on top of each other in this case; now ZipIt will attempt to at least stagger 
the windows vertically.

• Changed the font used in displaying file comments so that a linefeed character is now 
invisible. Since zip comments usually have carriage returns followed by linefeeds, this 
should make most comments look nicer.

• When only unzipping a single file, the save all button is now dimmed (since 1.1b4 or 



so). Fixed Bus error that this was causing (1.1b10).

• Changed comment icon from a small generic document icon to a balloon icon. This is 
to prepare for the next release, which will include icons for every file, and will use the 
generic document icon to represent binary files.

• Fixed bug introduced in 1.1 betas (possibly present in 1.0 as well) that would cause 
printing an archive from the Finder to fail miserably.
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